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9 Data analyses 

To analyze data, a tabular preparation of the data or a chart are very suitable. Using crosstabs 

or pivot tables, you present the selected data in tabular form and with a pivot chart, you display 

them as a chart. 

9.1 Crosstabs 

In Datasheet view, traditional queries look like regular tables: field names serve as column 

headings and each record appears in a row. On the other hand, crosstab queries group data by 

two different criteria and use them as column and row headings (in our example, the Company 

and ItemName fields of the Sales data query (Order database) with the Ladies' pants, Ladies' 

shoes, and Sweatshirt values). By shifting one of the groupings from the rows on the left to the 

columns at the top, you cross one or several groupings on the left with one grouping at the top. 

At their intersection, you'll find the calculated values. In addition to grouping and sorting data, 

crosstabs serve to execute functions such as the calculation of totals or average values. 

Company Total price Ladies' pants Ladies' shoes Sweatshirt 

Amag $44,052.00 $41,004.00 $3,048.00  

Flygt $76,200.00  $76,200.00  

Procedure: 

Open the Order.accdb database in case it is closed. In our example, we want to create a cross-

tab for the Sales data query with the Company, ItemName, and Sales price fields: 

 

Sales data query 

1. On the Create tab, in the Queries group, click the Query De-

sign button. 

2. The Show Table dialog box appears. On the Queries tab, se-

lect Sales data. 

3. Click the [Add] and [Close] buttons. 

4. On the Design tab (Query Tools), in the Query Type group, 

click the Crosstab button. Afterward, the Field Properties area 

contains all the necessary rows; the Total and Crosstab rows 

have been added: 

 

Queries group 
(Create tab) 

 

 
Query Type group, 

Design tab (Query Tools) 
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Query design with the Total and Crosstab rows 

5. Now, the Company, ItemName and Sales price fields are inserted and in the Total and 

Crosstab rows, the appropriate criteria are selected. Adding Sales price twice and select-

ing Sum and Row Heading in the relevant fields also calculates the sum total. To add an 

informative heading to the sum total, we type in Sum total followed by a colon in front of 

Sales price, as usual: 

First column: Select the field for the first grouping: Drag the Company field from 

Sales data to the Field row using the mouse. The Total row auto-

matically displays Group By. In the Crosstab row, select Row Head-

ing. 

Second column: Specify the ItemName field as the second grouping. In the Crosstab 

row, select Column Heading. 

Third column: Add Sales price from Sales data. In the Total row, select the Sum 

function and in the Crosstab row, select Value. 

Fourth column: Optional: Use the field of the third column again, place the cursor in 

front of the first letter and type in Sum total:. In the Total row, select 

Sum and in the Crosstab row, select Row Heading. 

Now, the following entries must be in the Crosstab row: 

Row Heading for the first grouping 

Column Heading for the second grouping 

Value for the subtotals 

Row Heading for the sum total. 

 

Selection in the Total and Crosstab rows 

Unfortunately, sorting by the columns of the Sum aggregate function isn't possible; Access 

displays a message: 

 

Aggregate function not possible 
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6. To create the crosstab query, click the Run button on the Design 

tab (Query Tools) in the Results group. 

 

Crosstab result with sum total 

 

Results group 
(Design tab) 

If a criterion is missing, Access will notify you: 

 

Notification 

If you don't want to display a sum total, three columns with one criterion each in the Cross-

tab row are sufficient. 

7. Save the query with the name Crosstab. 

 
The crosstab can also be created with the help of the query wizard. You will then be 

led through the single dialogs. 

9.2 Exercise 

1. Open the Customer management.accdb file. 

2. From the Price per customer and course query, we want to create a crosstab with the 

following values: 

Last name, Course name, and Total price. 

3. Save the query with the name Crosstab1 customer management: 

 

Crosstab result 

The solution can be found on page 150. 

9.3 Creating pivot tables in Excel 

Pivot tables cannot be created in Access anymore, but only in Excel. They are interactive tables 

to summarize large amounts of data quickly. You can use a pivot table to analyze and view data 

from different perspectives. It provides users with a tool for convenient analysis options and 

flexible evaluations. Thanks to the pivot function, you can view your data from a completely 

different perspective. In addition, you can view the overall result of each column and the detail 
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data can be hidden. As far as the presentation is concerned, they are very similar to crosstabs. 

When creating a pivot table, the Excel PivotTable Tools help you maximize your performance. 

The Sales data query is to be exported to Excel as a table: 

1. Open the Order.accdb database and select the Sales data query. 

2. On the External Data tab, in the Export group, click the Excel button. 

3. In the following dialog box, the file name of the destination file has already 

been entered. If need be, you can change the path by clicking [Browse]. 
 

 

Exporting to Excel 

4. Select the  Export data… and  Open the destination file… export options and click 

[_OK_]. The Sales data.xlsx file is opened in Excel: 

 

The Sales data database query as a table in Excel 
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To create a pivot table, Excel provides you with PivotTable Tools that make handling pivot 

tables easier. 

1. On the Insert tab of the ribbon, in the Tables group, click the Pivot-

Table button. 

2. In the following dialog box, specify where Excel is to retrieve the 

data for the pivot table from. In case of an external data source, the 

program offers several connection options. Activate the  Select a 

table or range option.  

 

Insert tab, 
Tables group 

3. Verify Excel's suggestion for the table range. For the current example, we need the range 

A1 to D9: 

 

Specifying the table range 

4. Choose where you want the PivotTable report to be placed:  New Worksheet. 

5. Click the [_OK_] button. Excel inserts the Sheet1 worksheet which shows some new things: 

 

The new Sheet1 has been prepared for the PivotTable report 
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Task pane 

On the right side, there is a task pane with the PivotTable 

Fields list. 

The border between the pane and the document can be moved 

with the mouse. Point the mouse to the vertical border. The 

mouse pointer becomes a double arrow: . While holding 

down the left mouse button, move the border to a new position 

and then release the button. 

You can also place the pane anywhere on the screen. Point the 

mouse to the pane's title bar, and, while holding down the left 

mouse button, drag the task pane to another position. For this 

task, the mouse pointer has the shape of a four-headed arrow. 

With a double-click on the title bar, you can return the task pane 

to its former position at the right of your Excel window. As with 

all windows, you can close the task pane by clicking the Close 

icon  in the title bar. 

The Tools icon  below the title bar opens the following sub-

menu. Here, the individual sections are rearranged, but only 

within the task pane: 

 

Task pane with the  
PivotTable Fields list 

 

Dragging the task pane to another 
position via the title bar 

 

Rearranging the sections within the task pane 

 

Area for the 
PivotTable report 

The area for the PivotTable report 

In the left part of the new Sheet1, an area has been prepared for the 

PivotTable report. The cell cursor is in this area. 

Contextual tabs 

On the ribbon, the PivotTable Tools context tool with the Analyze 

and Design tabs for editing pivot tables has been added. The contex-

tual tabs are automatically closed when the cursor exits the area for 

the PivotTable report. 
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Creating the PivotTable report 

1. The cell cursor is in the area designated for the PivotTable report. Thereby, the PivotTable 

Tools appear on the ribbon. 

If the PivotTable Fields task pane is closed, click the 

Field List button on the Analyze tab (PivotTable 

Tools) in the Show group. 

2. In the list, point to Company: . While holding down 

the left mouse button, drag the field name down to 

the Rows section of the task pane. After releasing 

the mouse button, the company names are placed in 

the A column. 

3. In the same way, copy the ItemName field to the 

Columns section 

4. and the Sales price field to the  Values section. 

Check the task pane on your screen: The check boxes of 

these three fields are now activated. The first PivotTable 

report is completed: 

 

 

Task pane 

 

The completed pivot table 

Now, you can alter the pivot table for you data analysis in mutliple ways. For example, in the 

 Values section, the values are automatically concatenated with a sum function. Instead of the 

sum, you can also use another function for the calculation. To do so, click the  

button in the  Values section. From the resulting menu, select Value Field Settings. 

Moreover, you can change the fields and positions in the pivot table, e.g., transpose rows and 

columns or filter and sort the data. This provides you with a great variety of possibilities of ana-

lyzing your data from different perspectives. 

To create a pivot chart, click the PivotChart button on the Analyze tab (PivotTable Tools) in 

the Tools group and select the chart from the Insert Chart dialog box. 
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Pivot table with pivot chart 

When you switch back to Access, the Export - Excel Spreadsheet window (page 107) is still 

open. It isn't necessary to save the export steps. [Close] the window. 

9.4 Excercise 

Open the Customer management.accdb database and from the Price per customer and 

course query, create a pivot chart in Excel (Insert tab) with the following details: 

 Course name in the Legend (Series) section 

 Last name in the Axis (Categories) section 

 Price in the  Values section. 

In the end, switch rows and columns (Design tab (PivotChart Tools)): 

 

Pivot chart after switching rows/columns 

The solution can be found on page 151. 
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12 Data Exchange 

Data can be exported from Access to other applications in order to process them futher there, 

e.g., in Excel. Similarily, data can be imported from other programs or linked. 

Examples: 

 Another Access database 

 Excel 

 HTML 

 Text file 

Basic procedure: 

On the External Data tab, you can find the Import & Link and Export groups. 

 

External Data tab 

Select the required application. A dialog box appears which has to be confirmed with [_OK_] 

after having entered the parameters. 

12.1 Import – structure of a database 

To archive the data at the end of each year, create a new database with the name Or-

der_archive.accdb which shall contain only the structure of the database. Therefore, only the 

structure of the tables are to be imported. 

1. Open a new, blank database and on the External Data tab, in the Import & Link group, 

click the New Data Source button, point to From Database in the submenu, and select 

Access. 

 

Submenu of the New Data Source button 

2. In the following dialog box, enter the folder and Access file or click [Browse] and select the 

file in the File Open window. 
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Importing a database 

3. Select the  Import… option and click [_OK_]. 

4. The Import Objects dialog box with the corresponding tables appears: 

 

Importing the tables 

In this dialog box, click [Options_>>]. 

5. Select all the tables and below Import Tables, activate the  Definition Only option, as 

we don't want to insert the data until the end of each year. 
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Importing only the definitions of the tables 

6. After clicking [_OK_], you can also choose whether to save the import steps. This makes 

sense, when the same import is to be carried out multiple times. 

 

Saving the import steps? 

The structure of the tables is created in the new database. In the same way, you can im-

port all other objects of the selected database. 

7. Save the database with the name Order_archive.accdb (File menu, Save As, Save Data-

base As). 

12.2 Export 

The Sales data query has already been exported to Excel as a table on page 107. Now, the 

Sales per customer query is to be saved as an HTML document: 
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1. In the Order.accdb database, select the Sales per customer query and on the External 

Data tab, in the Export group, click the More button and select HTML Document from the 

submenu. 

 

Export – HTML document 

2. The first dialog box appears. The file name of the destination file with its entire file path has 

already been entered. If need be, change the path by clicking [Browse]. Select the first ex-

port option  Export data … and click [_OK_]: 

 

Exporting to HTML 

3. In the following dialog box, keep the default settings: 
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Default encoding 

4. Here, you can save the export steps: 

 

Here, you can save the export steps 

5. To call up the file, open the file explorer, navigate to the folder in which you saved the file in 

step 2, and double-click the file name. 

 

File explorer 

6. The file is then opened in your default web browser, e.g., Internet Explorer. 
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Sales per customer HTML file 

12.3 Links 

The Excel table Customers.xlsx is to be linked to a new database table in the Order database. 

Proceed as follows: 

1. On the External Data tab, in the Import & Link group, click the New 

Data Source button, point to From File in the submenu, and select 

Excel. In the following dialog box, activate the  Link to the data 

source… option and select the path to the Excel table via the 

[Browse] button: 

 

 

Linking an Excel table 

2. Click [_OK_]. The data of the table are displayed. 
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.  

Customers Excel table 

3. If the table contains a row with column headings, the  First Row Contains Column 

Headings option must be activated. Click [_Next_]. 

4. Enter a name for the new database table, for example, Customers from Excel, and click 

the [Finish] button. 

 

New database table 

5. Confirm the following message with [_OK_]. 

 

The linking is finished 

http://www.dettmer-verlag.de/


 Schulungsunterlage Access 2016 Weiterführung Englisch  

 142 Musterseite aus dem Dettmer-Verlag, D-76889 Kapellen 

www.dettmer-verlag.de 

6. The database table has been created and will automatically be updated, when the original 

table – the Excel table – is altered. 

 

Customers from Excel database table 

Please note: 

The path to the linked application must not be changed and the Excel table must not be moved. 

Otherwise, a message appears. 

12.4 Linked Table Manager 

In the version of 2016, Access provides you with a manager to up-

date linked Excel tables: On the External Data tab, in the Import & 

Link group, click the button shown on the right. The following dialog 

box appears: 

 

In the Import & Link group 

 

Dialog box for updating the linked Excet tables (example) 

To update a linked table, select the corresponding line(s) and click the [_OK_] button. 

12.5 Excercise 

Importing an Excel table – adding records 

Import the Participants_new.xlsx Excel table into the Course management database. It con-

tains new data that are to be added to the Participants table. Then save the import with a me-

aningful name. 

 

The Participants database table 

The solution can be found on page 170. 
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Calling up saved imports 

After extending and updating the Participants_new.xlsx Excel table, 

you can now call-up the import via the Saved Import button on the 

External Data tab in the Import & Link group. 

Select the relevant import and click the [_Run_] button. 

 

In the Import & Link group 
(External Data tab) 

 

Calling up saved imports 

The data you have added to the Excel table are appended to the database table. 
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